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Excel PivotTables Overview

Working with PivotTables
Examining PivotTables

Explanation

By analyzing data, you can make more informed decisions. Excel provides the

PivotTable fe
summarizes,

ature to help you examine data. A PivotTable is an interactive table that
organizes, and compares large amounts of data in a worksheet. You can

rotate the rows and columns in a PivotTable to obtain different views of the same data.
You can use a PivotTable to analyze data in an Excel workbook or data from an external
database, such as Microsoft Access or SQL Server.

The data on which a PivotTable is based is called the source data. Each column
represents a field, or category of information, which you can assign to different parts of

the PivotTabl

e to determine how the data is arranged. You can add four types of fields:

Field Description

Filters Filters the summarized data in a PivotTable. If you select an item in the
report filter, the view of the PivotTable changes to display only the
summarized data associated with that item. For example, if Region is a
report filter, you can display the summarized data for the North region,
the West region, or all regions.

Rows Displays the items in a field as row labels. For example, the row labels are
values in the Quarter field, which means that the table shows one row for
each quarter.

Columns  Displays the items in a field as column labels. For example, the column
labels are values in the Product field, which means that the table shows
one column for each product.

> Values Contains the summarized data. These fields usually contain numeric data,
such as sales and inventory figures. The area where the data itself
appears is called the data area.

Report Columns
filter list filter list
A B C D E F G
Report filter ———Region (All) -
2
3 Sum of Sales Column Labels |~
Rows —=%—Row Labels v Anise Seeds Basil L loves Grand Total
filter list 5 Qtrl ‘ 80115 238684 150837 173047 1345
6 |Qtr2 149449 82151 240398 166792 178253 8170
> values 7 Qs 144931 84346 250219 169073 181556 83012
g Qird Mzc 247687 168926 1222‘:)924
9 Grand Total 58084 2076988 655028 L 3254477
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The PivotTable Command

You use the PivotTable command to create a PivotTable. Here’s how:

Excel PivotTables Overview

1. Select any cell in a data range that includes a heading for each column in the

top row.
2. Click the Insert tab.

3. Inthe Tables group, click the PivotTable button to open the Create PivotTable

dialog box.

4. Inthe Table/Range box, select the range that contains the data you want to

use in the PivotTable.

5. Select a location for the PivotTable. You can place the PivotTable in a new or

existing worksheet.
6. Click OK.

When you insert or work with PivotTables, Excel displays the PivotTable Tools, adding
Analyze and Design tabs to the ribbon.

Create PivotTable
Choose the data that you want to analyze
@ Select a kable or range
TablefRange: | Sales Data "15452:5FS1000

Use an external data source

Connection narne:

ant the PivatTable report to be placed

Existing Worksheet

Location:

[ =

=

=

=

55

[ 074

] | Cancel

The Create PivotTable dialog box

Using an external data source

You can use an external data source as the data for the PivotTable. To do so:
1. Inan empty worksheet, click the Insert tab and click the PivotTable button.
2. Inthe Create PivotTables dialog box, select “Use an external data source” and

click Choose Connection.

3. From the list of connections, select the desired connection, such as Access
database. If the connection you want is not showing, click Browse for More.
4. Click Open. The selected data source appears as the Connection name.

5. Click OK to continue crea

Add fields

ting the PivotTable.

You add fields to a PivotTable to specify the data you want to display. The fields of the
source data appear in the PivotTable Field List pane.

To add fields, drag a field from the top of the PivotTable Fields task pane to one of the

four areas at the bottom of the p
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PivotTable Fields v X

Choose fields to add to report: A
Date -
Customer
Item
Units
Cost
Total Sale -

Drag fields between areas below:

FILTERS COLUMMNS
ROWS VALUES
Custmer
=

Defer Layout Update

Adding a field to the PivotTable
Using fields to filter data

After the fields are in place, you can filter the information that appears in the table by
selecting options from the filter lists available for each field. For example, you can show
all data values or restrict the PivotTable to summarizing only a couple of values.

When a filter has been applied, the arrow changes to a filter icon (it looks like a funnel).
You can click this icon to display the filter list and see which filter has been applied.

To remove a filter, display the filter list and choose the Clear Filter option. You can also
display the filter list by clicking the corresponding filter icon in the PivotTable Field list
pane.

Inserting slicers

Explanation In Excel, you can insert a slicer to easily show the current filtered state of the data. You
can create a slice for each field in the PivotTable.

Slicers are visual controls you can use to quickly filter your data by selecting values from
a list. Slicers are both “live” —they reflect data changes in the underlying PivotTable—
and interactive—you can select filter fields on the fly. Slicers appear as separate objects
on the worksheet and can be moved around and resized.

To insert a slicer:
1. Select any cell in the PivotTable.
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2. Click the PivotTable Tools | Analyze tab. In the Filter group, click Insert Slicer.
The Insert Slicer dialog box appears with a list of the PivotTable fields.
3. Check the fields you want to display as slicers.
4. Click OK. The slicers appear on top of the PivotTable, and the Slicer Tools |

Options tab appears on the ribbon.

Using slicers to filter data

Even though the slicers are overlapping, it’s possible to see which filters are selected.
The selected items on the slicer indicate which filter is being applied. On the Region
slicer, Central is the only highlighted item. The Product slicer indicates that no filter is
applied because all items are selected (or highlighted).

To change a slicer filter, click the item you want to use as the filter. Use the Ctrl+click
method to select multiple items. Use the Shift+click method to select contiguous items.
To clear the filter, click the Clear Filter button at the right end of the slicer header.

Modifying slicers

Excel considers slicers to be shapes. Therefore, you can move, resize, align, and format
slicers just as you would other shapes. To move a slicer, drag the slicer header to the
desired location. Drag a slicer’s border to change the size of the slicer. Use the Slicer
Tools | Options tab to apply a slicer style and to align the slicers.

Deleting slicers

You can quickly delete a slicer by selecting it and pressing Delete. You can also right-click
the slicer and choose Remove “Slicer Name” from the shortcut menu. The slicer is
immediately removed.

H - i - =1k My Sales analysis.xisx - Bxcel 7@ - B %
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3 sum of Total Sale Column Labels [~
4 Row Labels | Cogs Gadgets
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6 |Accounts Now 41821 1020
7 | Award Sportswear 10381 1965.2
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The PivotTable with slicers
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Modifying PivotTable data

Explanation

Explanation

Explanation
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Group data

You may have certain data in your PivotTable that needs to be further summarized. You
can do this by grouping the data.

You can group text fields, number fields, and date fields. To group data:
1. Select a row or column cell containing the type of data you want to group.
2. On the Analyze tab, click Group, and select a grouping option. Alternatively,
you can right-click the cell and choose Group form the shortcut menu.
3. Inthe Grouping dialog box, enter the Starting at: and Ending at: values, and
enter or select a By: value.
4. Click Ok.

Move fields

After creating a PivotTable, you might want to display an entirely different view of the
data. You can change the data view by dragging the fields to the other areas in the
PivotTable. The PivotTable provides options to show or hide the details. To change data
in the PivotTable, however, you need to refresh the table after changing the source
data.

You can move a field in a PivotTable by dragging the field to a new area in the
PivotTable Field List pane. To show a columnar view of the data drag a report or row
field to the Column Labels box in the pane. When you want to arrange data in row
fields, drag a report or column field to the Row Labels box in the pane.

Sum of Total Sale Column Labels -~

Row Labels | Otrl Qtr2 Qtr3 Qtrd Grand Total
Cogs 21098.8 19641 179836 15262.2 73985.6
Gadgets 18926.7 15489.8 16689.6 25765.3 TEE51.6
Sprockets 13962 22503.2 17686.2 166947 708461
Widgets 21151.7 22911.8 17487 151123 FEE62.8
Grand Total ¥5139.2 B80525.8 69840.4 7F2834.7 298346.1

A PivotTable with fields rearranged and records grouped by date

Refreshing PivotTable data
You cannot directly change the data in a PivotTable because it’s based on source data.
To change data in a PivotTable, you must first change the source data and then refresh

the PivotTable to reflect the changes.

You can refresh the PivotTable by clicking the Refresh button in the Data group on the
Analyze tab.
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Formatting PivotTables

Explanation

Explanation

Formatting PivotTable data

Excel PivotTables Overview

You can change the format of a PivotTable by using styles and the Field Settings dialog
box. You can use styles to format an entire PivotTable in one step. You can use the Field
Settings dialog box to change number formats, specify how data is summarized, and

show or hide data.

Using styles

To display formatting options that affect the entire PivotTable, click the PivotTable Tools
| Design tab. Some of the styles are specifically designed for PivotTables.

Sum of Total Sale Column Labels @

Row Labels Cogs Gadgets Sprockets Widgets Grand Tota
Central 2127.8 658 6453 2388.3 a8139.
ACcounts Mow 41821 1ozn 861.3 236 6319,
Sweard Sportswear 10381 1965.2 6243  1566.9 5154,
Blastera 17132 2269.7 1241  1e74.2 7398,
BlazerFire 8183 13631 9477 3184.5 6313,

A sample PivotTable style

Change field settings

You can change field settings to alter how data appears or is summarized in a

PivotTable. To change field settings:
1. Select any cell in the data area.
2. Click the PivotTables Tools | Analyze tab.

3. Inthe Active Field group, click Field Settings to open the Value Field Settings

dialog box.

4. Click the Number Format button to open the Format Cells dialog box. Select

the desired options and click OK.
5. Click OK.
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Value Field Settings [0 |

Source Name: Total Sale

Custom Mame: | Sum of Total Sale

Summarize Values By | Show Yalues 4s

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field
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The Value Field Settings dialog box

Using PivotCharts
Creating PivotCharts

Explanation  You can use a PivotChart to graphically display data from a PivotTable. A single
PivotChart provides different views of the same data.

When you create a PivotChart, the row fields of the PivotTable become the categories,
and the column fields become the series.

To create a PivotChart, select any cell in a PivotTable and click PivotChart in the Tools
group on the PivotTable Tools | Analyze tab. In the Insert Chart dialog box, select
options as you would for a standard chart, and click OK.

You can also create a new PivotChart and PivotTable at the same time. To do so, you
select a cell in the source data, click the Insert tab, click the PivotTable button’s arrow
(in the Charts group), and choose PivotChart & PivotTable.

Changing the view of a PivotChart

PivotCharts contain field buttons that are used to change what is displayed for a
specific field. For example, to change the regions shown in the sample PivotChart, click
the Region field button and select the regions you want to show. The same method
can be used to filter the Product and Quarter fields.
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Product «
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A PivotChart
PivotChart styles

As with PivotTables, you can apply built-in styles to your PivotChart. To do so:
1. Select the PivotChart.
2. Onthe Design tab, in the Chart Styles group, select the desired chart style.
3. Alternatively, click the Chart Styles button to the right of the selected chart,
and choose a style from the gallery.
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